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Introduction 

This Getting Started document will help you to install and configure the Hardware and 
Software tools necessary to operate the TriCore Free Entry Tool Chain. At the end of the 
instructions described in this document, you will have a running environment that could 
be used as a starting point for further development or evaluation work. 

This tutorial goes step-by-step through the necessary procedures in order to: 

 Install the TriCore Free Entry Tool Chain 

 Set up a project 

 Configure the Evaluation Board and connect it to the PC 

 Debug your application 

 

If you need more information, please contact your nearest Infineon sale’s office. Contact 
information is available on Infineon web site: www.infineon.com.  

We wish you a lot of success with the TriCore Free Entry Tool Chain! 

 

Note: "Starter Kit Evaluation Board", "Evaluation Board", "TriBoard" and "Target" 
terminology are used to denote Evaluation Boards as shown in Figure 14 to 21. 
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Installing the TriCore Free Entry 
Tool Chain 

Before you start 

To execute this Getting Started, it is necessary to have a  

 Microsoft Windows compatible PC equipped with USB port 

 Operating System Windows Vista, Windows 7, Windows 8(.1), Windows 10 
(32/64 bit versions)  

 Power user’s or administrator rights are mandatory to install the required 
programs 

 During installation a connection to the internet is required 
for license activation 

All the items below are included in the Starter Kit. 

 Power Supply  (AC/DC converter) (5.5V – 60V) for the Starter Kit Board (optional) 

 TriCore Family Starter Kit Evaluation Board  

 TriCore Free Entry Tool Chain installation package 

 USB cable. 

System Requirements 

Before installing, make sure the following minimum system requirements are met: 

 1 GHz or faster 32-bit (x86) or 64-bit (x64) processor 

 1 GByte RAM (32-bit) or 2 GByte RAM (64-bit) 

 3 GByte available hard disk space 

 Microsoft .NET™ Framework 3.5 SP1 

 Microsoft Windows Scripting Host V5.6 

 Microsoft Internet Explorer® 9.0 or higher  

 Java Runtime Environment v8 (32-bit version)  

 Adobe® Acrobat Reader 10.0 or higher. 
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Installation 

1. From the installation package run the installer setup.exe. TriCore Free Entry Tool 
Chain dialog appears (Figure 1) 

 

 
Figure 1 TriCore Free Entry Tool Chain Setup dialog 

 

2. Select Next button. The License Agreement dialog appears. Please read carefully 
and agree or cancel the installation with Cancel button (Figure 2) 

 

 
Figure 2 License Agreement dialog 
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3. Select Next button. In the next dialog you can decide if the tool chain will installed 
only for your profile or for all users of the computer (Figure 3) 

 

 
Figure 3 TriCore Free Entry Tool Chain Setup dialog 

 

4. Click Next button. The dialog for selecting the installation directory appears (Figure 
4). Use the default or select another installation directory. 

 

 
Figure 4 TriCore Free Entry Tool Chain Setup folder dialog 
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5. Please select mode and click Next. Now the ProductSelection dialog with the 
predefined product key appears (Figure 5). No user action is needed. 

 

 
Figure 5 ProductSelection dialog 

 

6. Click Next. Different dialogs inform you about the progress of installation. 

Please note: For commercial development you need the full version of TriCore 
Development Platform.  

The TriCore Free Entry Level Tool Chain cannot be used together with professional 
versions of the containing products because they are incompatible. That’s why, it is not 
possible to use a parallel installation of the TriCore Free Entry Level Tool Chain 
together with a professional version UDE 4.4. 
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To avoid destroying of an installation of a professional version of UDE, please cancel the 
UDE 4.4 installation dialog (Figure 6) which only appears if an UDE 4.4 installation is 
already on the computer. 

 

 
Figure 6 UDE 4.4 installation warning 

 

Note: The TriCore Free Entry Tool Chain license is valid for at least one year. There are 
following restrictions in comparison to the professional version: 

Useable for TriCore evaluation boards with on-board wiggler only, PCP assembler only, 
Debugger: No visualization functions at runtime, no MCDS support, no Script support. 

Please contact tctcsupport@pls-mc.com for extending the license. 
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First Starting of Eclipse 

Starting Eclipse 

1. From the Windows’ Start menu, select All Programs - Free AURIX Entry Tool 
Chain v4.6.6.0-infineon-1.1 - Eclipse or use the Desktop icon Eclipse for TriCore. 

2. Now the Workspace Launcher dialog appears (Figure 7). 

 

 
Figure 7 Workspace Launcher 

3. Enter the path to the workspace directory e.g. D:\Workspace. If the directory 

doesn’t exist, new directory will be created; otherwise existing directory will be used 
as eclipse workspace. New created projects will be saved in the selected workspace 
directory.  

4. You can enable the option Use this as the default and do not ask again. By next 
start last used workspace will be used, skipping the Workspace Launcher dialog. If 
you want to use other or new workspace. Select from the File menu Switch 
Workspace. 

5. Click OK to proceed. 

6. The HighTec Licensing dialog appears (Figure 8) 

 

 
Figure 8 HighTec Licensing dialog 

Click Yes to proceed. 
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7. To add a license a dialog for Activation and Registration of a license appears  
(Figure 9). 

 

 
Figure 9 Add license dialog 

It shows the products for the license activation. Further some data are requested. User 
name, e-mail address and company are needed and department and phone number are 
optional. 

8. After pressing Finish the license will generated. The license file is located in the 
directory where the environment variable HTC_LICENSES points to and is also 
visible in the license manager page of eclipse plug-in from HighTec. 

Note: License activation fails if the Avira Security Suite is used. The error message is: 
"Bad return data from webserver (no status)(-134)". Please deactivate the browser 
protection for a short time to allow license activation. 

The Welcome view (Fehler! Verweisquelle konnte nicht gefunden werden.) appears. 

Note: Step 2 to 4 are needed only at the first time start. 

Initially, Eclipse opens with a workbench displaying the C/C++ perspective with only the 
Welcome view visible. This view provides some general information and alternative ways 
to access the online documentation. 

Eclipse opens with the perspective which was last used before closing, except when 
starting up for the very first time showing the Welcome view. 
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9. Click the Workbench on the right side of the view to go to the workbench. Assuming 
first start of eclipse, HighTec perspective (Figure 10) appears, otherwise last saved 
workbench layout. 

 

 
Figure 10 HighTec perspective 
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Create an AURIX Project 

C/C++ Project wizard 

This tutorial shows how to create an embedded software project with the TriCore toolset. 
It lets you create your own project with an example of an analogue clock on the display of 
the AURIX application kit.  

Set the HighTec C/C++ perspective 

Before creating a TriCore project, it is necessary to have the HighTec C/C++ perspective 
on the workbench (Figure 11). By default, this should be the case when you start Eclipse, 
but if it is not, do the following. 

To open the HighTec C/C++ perspective 

1. From the Window menu select Open Perspective - Other... - HighTec. The name 
of the perspective is displayed in the title bar of the workbench window 



 

14 of 36    Import a sample Project Create an AURIX Project 

Import a sample Project 

1. From the File menu select New - Example (Figure 11). The New Example wizard 
appears (Figure 12). 

 

 
Figure 11 Menu File / New / Example 

2. Select HighTec Examples and press Next. 

 

 
Figure 12 New Example Wizard 
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3. The next wizard page (Figure 13) shows a selection tree containing the TriCore 
boards supported by the toolchain. Expand the sample node e.g. TimeDemo and 
select AppKit-TC224TFT. Press Next. 

 

 
Figure 13 Examples – Hardware Selection 

4. Click Finish to finish the wizard and to import the example.  

Figure 14 shows HighTec perspective with the new created project. To see the generated 
project files you may need to expand the hello project structure on the left pane. To open 
one generated file double-click the file in the src folder of the project structure. 

 

 
Figure 14 HighTec C/C++ Perspective with the new imported example 
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Start with an empty Project 

To start from an empty project following the steps from the previous section Import a 

sample project and simply remove all header files from the h folder and the file timer.c 

from the src folder and delete the content of the file timedemo.c except an empty 

main() function.  

Build the Project 

When you build an AURIX C/C++ project in Eclipse, the HighTec TriCore compiler, 
assembler and linker are used to compile and link all the source code and the libraries 
associated with the project.  

The wizard generates different build targets like iROM (default). You can choose a build 

configuration by clicking the arrow of the build icon and build a target by clicking the 

build icon .  

Meaning of build targets 

 iROM Code will be located in the internal flash (default) 

During the build process the sources belonging to the project will be compiled and linked. 
The messages occurring during the build process are displayed in the Console window 
(Figure 15).  The build process should terminate without giving any errors or warnings. 

 

 
Figure 15 HighTec C/C++ Perspective: Build button and Console window 
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Connecting the Target 

TriBoard with mounted TC2D5T, TC2xxA, TC2xxB, 
TC2xxC processor 

1. Configure the DIP switches (1,2,3=OFF 4=ON but for A step (!) 1=ON 2,3,4=OFF)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 16 AURIX – TriBoard 
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Application Kit AURIX TC2X4 TFT with TC224, TC234 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC2X5 to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the Reset button (see picture below) 

 

 
 

 
 

 

 

Back side Top side 

 
Figure 17 AURIX Application Kit TC2X4 TFT 
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Application Kit AURIX TC2X5 TFT with TC265 

 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC2X5 to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the Reset button (see picture below) 

 

 

 
 

 

 

Back side Top side 

 
Figure 18 AURIX Application Kit TC2X5 
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Application Kit AURIX TC2X7 TFT with TC297, TC277, 
TC267, TC237 

1. Connect a DC power supply (5.5V – 60V) to the Application Kit.  

2. Connect the Application Kit TC2X5 to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the Reset button (see picture below) 

 

 

 
 

 

 

Back side Top side 

 
Figure 19 AURIX Application Kit TC2X7 
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TriBoard with mounted TC1767 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 20 TC1767 - TriBoard 
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TriBoard with mounted TC1797 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 21 TC1797 - TriBoard 
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TriBoard with mounted TC1782 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 22 TC1782  - TriBoard 
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TriBoard with mounted TC1724 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 23 TC1724  - TriBoard 
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TriBoard with mounted TC1791 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 24 TC1791  - TriBoard 
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TriBoard with mounted TC1793 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 25 TC1793  - TriBoard 
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TriBoard with mounted TC1798 processor 

1. Configure the DIP switches (default all OFF - boot from internal flash)  

2. Connect a DC power supply (5.5V – 60V) to the TriBoard.  

3. Connect the TriBoard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

4. Three Power Supply PS-LEDs should be on. 

5. Press the Reset button (see picture below) 

 

 
Figure 26 TC1798 - TriBoard 



 

28 of 36    phyCORE-TC1793 with baseboard Connecting the Target 

phyCORE-TC1793 with baseboard 

1. Connect a DC power supply (5.5V – 60V) to the baseboard 

2. Connect the baseboard to the PC via a USB cable 
(a cable is supplied with the Starter Kit). 

3. The Power Supply  LED should be on. 

4. Press the Reset button (see picture below) 

 

 
Figure 27 phyCORE - TC1793 with baseboard 
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Debugging your Application 

Start a Debug Session  

1. Open the context menu (left mouse click) at the debug button and select Debug 
Configurations ... (Figure 28). 
 

 
Figure 28 Select Debug Configurations dialog via Debug button 
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2. The Debug Configurations dialog appears. Select Universal Debug Engine as 
debug type (Figure 29). 

 

 
Figure 29 Debug Configurations dialog 

3. Press the New launch configuration button to create a new debug launch 
configuration for Universal Debug Engine (Figure 30). 

 

 
Figure 30 Create new debug launch configuration for Universal Debug Engine 
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4. A new debug configuration TimeDemo_AppKit_TC224TFT iROM is created. All 
input fields are pre-filled with appropriate values (Figure 31). 

5. Push Debug to start UDE perspective. Later you can use the Debug icon  from 
the menu. 

Note: If a problem occurred pop-up window appears, click OK, check the USB cable 
connection, reset the board with the reset button, and start again the Debug session  

6. If you built an iROM version of your application, the UDE Memory Programming 
Tool will appear after launching the UDE perspective (Figure 31). 

 

 
Figure 31 UDE Memory Programming Tool 

7. Start flashing with the Program button. A progress dialog appears (Figure 32). After 
successful programming close both dialogs. 

 

 
Figure 32 FLASH programming progress dialog 
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From the Debug menu, select Step over subroutine, or click on the Step over button 

 in the toolbar. At this moment your application is executing but stopped on the 

function main(). This means the C startup code has been executed completely. The 

Editor view shows the C source files of your application and a yellow arrow shows the line 
where the execution has stopped (Figure 33). 

 

 
Figure 33 First step to main() function 

Stepping through the Application 

1. From the Debug menu select Step over subroutine or click on the Step over button  

 in the toolbar. The yellow arrow in the Program view moves to the next 
statement. 

2. To set or clear breakpoints click on the markers in the info margin of program 
window. 

3. To see watch or local variables please open the accordingly window 
via the View menu. 

4. To run your application, select Start Program Execution from the Debug menu or 

click on the Start Program button  in the toolbar. Now an analogue clock should 
be visible on the display of the application kit. 

5. To restart your application, select Restart Program Execution from the Debug 

menu, or press F7 or click on the Restart button  in the toolbar. 
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Using the UDE debugger 

The main() and further features of UDE are described in the UDE Manual, available via 
UDE Welcome Page. Open it via menu Window - Show View - Other ... - Universal 
Debug Engine - UDE Welcome Page and push the UDE Manual button.  

Figure 34 shows an UDE example configuration with SFR, Call stack, Watch window, and 
Memory window. All features are described in the UDE Manual. 

 

 
Figure 34 Universal Debug Engine perspective 
 

End the Debug Session 

From the File menu select Close Workspace or click on the Close Workspace  button 
in the toolbar. The current perspective is switched back to the HighTec C/C++ 
perspective. 

Summary 

Having followed the step-by-step instructions the development environment comprising 
TriCore Free Entry Tool Chain and TriCore Family Evaluation Board will have now been 
installed. After creating and compiling a simple program, it is successfully executed on 
the Evaluation Board. 

You now have a running environment that could be used for further development or 
evaluation work. 
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